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ABSTRAK 

 

Proses pembelajaran yang selama ini dilakukan seorang guru di kelas lebih banyak 

dengan guru melakukan sebuah presentasi yang monoton dengan hanya memanfaatkan media 

papan tulis. 

Mulai tahun ajaran 2003/2004 di DIY mulai diimplementasikan Kurikulum Berbasis 

Kompetensi (KBK). Kurikulum ini diunggulkan karena diharapkan untuk setiap jenjang 

kelulusannya akan dapat memenuhi tuntutan dunia kerja yang saat ini sedang menuju Era 

Globalisasi dimana lulusan kita untuk setiap jenjang akan berkompetitif dengan  lulusan dari 

mancanegara bahkan di dalam negerinya sendiri. Salah satu metode pembelajaran yang dapat 

diterapkan pada KBK ini adalah Contextual Teaching Learning (CTL) dimana salah satu aspek 

pembelajarannya adalah bersifat rekreasi dan menggunakan alat bantu komputer atau alat peraga.  

Sehingga untuk meningkatkan mutu pembelajaran yang dikelola di dalam kelas, adalah 

dengan memanfaatkan sebuah komputer serta program-program komputer yang ada untuk 

dikembangkan menjadi alat bantu pembelajaran di kelas. Salah satu program yang sesuai sebagai 

alat bantu presentasi di kelas adalah Power Point. 
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A. Mengenal Microsoft Power Point 

Microsoft Power Point adalah suatu software yang akan membantu dalam menyusun sebuah 

presentasi yang efektif, professional, dan juga mudah. Microsoft Power Point akan membantu 

sebuah gagasan menjadi lebih menarik dan jelas tujuannya jika dipresentasikan karena 

Microsoft Power Point akan membantu dalam pembuatan slide, outline presentasi, presentasi 

elektronika, menampilkan slide yang dinamis, termasuk clip art yang menarik, yang 

semuanya itu mudah ditampilkan di layar monitor komputer. Berikut tampilan awal area kerja 

Microsoft Power Point. 

 
Gambar 1. Tampilan are kerja MS Power Point 



Pada area kerja tersebut terdapat fasilitas-fasilitas yang diuraikan sebagai berikut: 

 

 Menu Bar : Daftar menu yang masing-masing terdiri dari beberapa perintah. 

 Standart Toolbar : Tools untuk menangani file, menyisipkan objek baik gambar atau 

grafik. 

 Formatting Toolbar : Tools yang terdiri dari item yang berhubungan dengan 

pengaturan huruf atau tulisan. 

 Slide Sorter View : Menampilkan keseluruhan slide di layar kerja dalam bentuk 

ukuran kecil. 

 Slide Show : Menampilkan tayangan sebuah slide. 



 Drawing Toolbar : Tools yang terdiri dari item yang berhubungan dengan pembuatan 

ataupun pengaturan gambar. 

 

B. Manipulasi Teks dan Gambar 

 

Drawing Toolbar 

 

 
 

1. Draw   : Mempermudah penempatan dan pengorganisasian objek,  

    misalnya dalam melakukan Grouping, Ordering, Rotate,  

    Text Wrapping, dan lain-lain. 

2. Select Object  : Melakukan pilihan terhadap obyek tertentu. 

3. AutoShapes  : Menyediakan berbagai macam pilihan bentuk yang dapat  

      mendukung penyajian presentasi seperti Callouts, Basic  

      Shape, Lines, Stars and Banners, dan lain-lain. 

4. Line   : Menggambar garis. 

5. Arrow   : Menggambar tanda panah. 

6. Rectangle  : Menggambar bentuk persegi. 

7. Oval   : Menggambar bentuk oval atau lingkaran. 

8. Text Box  : Membuat serangkaian text. 

9. Word Art  : Membuat efek-efek text yang menarik baik dalam bentuk  

      2D maupun 3D. 

10. Insert Clip Art :Menambahkan gambar ke dalam materi presentasi yang  

       sedang dipersiapkan, baik berasal dari default Powerpoint  

       maupun dari file yang kita miliki. 

11. Fill Color  : Memberikan pewarnaan terhadap suatu objek tertentu. 

12. Line Color  : Memberikan pewarnaan terhadap garis tepi dari suatu  

      objek. 

13. Font Color  : Memberikan pewarnaan terhadap text yang diseleksi. 

14. Line Style  : Memberikan pilihan ketebalan (dalam ukuran point)  

       terhadap model garis yang dipakai. 

15. Dash Style  : Memberikan pilihan terhadap mode garis yang dipakai. 

16. Arrow Style  : Memberikan pilihan terhadap mode arrow yang dipakai. 

17. Shadow  : Memberikan efek bayangan pada objek yang diseleksi  

       (tidak untuk text). 

18. 3-D   : Memberikan efek 3 dimensi pada objek yang diseleksi  

     (tidak untuk text). 

 

 

C. Membuat Slide Presentasi 

1. New Blank Presentation 

    Pada layar akan nampak slide seperti gambar berikut : 

 



 
Gambar 2. Slide Kosong 

 

Langkah – langkah yang dapat dilakukan dalam membuat slide : 

 

a) Membuat text 

1) Membuat judul 

    Klik pada tulisan “Click to add title” lalu ketikkan judul presentasi. 

2) Membuat textbox pada click to add text 

 Klik icon text box. 

 Klik pada bagian dari slide yang ingin ditambahkan tulisan. 

3) Menggunakan Bullet and Numbering 

 Klik area textbox yang ingin menggunakan Bullet and Numbering lalu klik 

Format > Bullets and Numbering > pilih yang akan digunakan. 

 Bila telah selesai maka klik di luar area textbox. 

    4) Membuat WordArt 

 Klik Insert > Picture > WordArt atau cari icon Insert WordArt pada Drawing 

Toolbar. 

 Pilih 1 model kemudian klik OK. 

 Muncul kotak dialog seperti Gambar 3 di bawah ini, lalu ketikkan tulisan yang 

diinginkan lalu klik OK. 

 



 
Gambar 3. Kotak dialog WordArt 

 

b) Menampilkan gambar 

1) Klik Insert > Picture lalu pilih Clip Art bila gambar yang ingin digunakan adalah 

gambar yang disediakan oleh Microsoft Office atau pilih From File bila ingin 

menggunakan gambar koleksi pribadi (untuk memilih akan muncul kotak dialog 

open kemudian cari lokasi filenya sampai ditemukan filenya). 

2) Atur sesuai keinginan lalu klik di bagian lain slide yang tidak ada gambar tersebut. 

 

c) Memberikan Background 

1) Klik kanan pada bagian slide yang kosong. 

2) Pilih Background. 

3) Muncul kotak dialog berikut. 

 

 
 

 Pilih More Colors dengan meng-klik drop down untuk mengatur warna yang 

diinginkan. 

 Pilih Fill Effect dengan meng-klik drop down untuk mengatur efek yang 

diinginkan dengan memilih pola gradient / texture / pattern yang diinginkan. 



4) Pilih Apply untuk memberi background pada 1 lembar slide yang sedang dipilih itu 

saja atau Apply to All untuk memberi background pada seluruh slide. 

 

d) Menambah Slide Presentasi 

1) Klik icon  pada formatting toolbar. 

2) Pilih salah satu tipe slide yang diinginkan. 

 

e) Menghapus Slide Presentasi 

1) Pilih Slide yang akan dihapus dengan cara meng-klik slide tersebut pada Outline 

Slide. 

2) Tekan Delete pada Keyboard. 

 

f) Memberi Animasi 

1) Klik kanan text atau objeknya. 

2) Klik Custom Animation. 

3) Pilih effects untuk memberikan animasi pada text atau objek yang diinginkan 

dengan memilih pada icon Animation Schemes. 

4) Setelah memilih efek yang diinginkan maka akan nampak sbb: 

 

 
 

g) Menambahkan Slide Transition 

1) Klik bagian slide di luar textbox lalu klik kanan pilih Slide Transition atau klik 

Slide Show pada Menu Bar lalu pilih Slide Transition. 

2) Lalu pilih jenis yang diinginkan pada tiap slide. 

3) Sesuaikan komponen lainnya seperti pada pemberian animasi. 

 

h) Membuat tabel 

1) Klik Insert pada Menu Bar lalu pilih Table. 



2) Isikan jumlah baris dan kolom tabel yang akan dibuat pada kotak dialog yang 

muncul. 

 
3) Untuk melakukan pengesetan lebih lanjut terhadap tabel yang ada dapat dilakukan 

dengan men-“double click” tabel tersebut atau meng-klik kanan pada bagian garis 

tabel tersebut dan memilih “Borders and Fill”. 

 

 
 

i) Membuat diagram 

1) Klik Insert pada Menu Bar lalu pilih Chart. 

2) Secara otomatis akan nampak tampilan sebagai berikut : 



 
 

3) Perubahan terhadap nama, jumlah, maupun data-data lain hanya dengan mengganti 

isi dari tabel pada Datasheet tersebut dan secara otomatis diagramnya akan ikut 

berubah mengikuti data pada tabel Datasheet. 

4) Bila sudah selesai klik di luar area Datasheet maka akan diperoleh grafik yang 

diinginkan (untuk mengeditnya kembali dapat dilakukan dengan men - “double 

click” diagram tersebut). 

5) Untuk melakukan pengaturan lainnya dapat dilakukan dengan meng-klik kanan 

bagian-bagian diagram sehingga tampilannya akan dapat disesuaikan sesuai 

keinginan. 

 

 
 

 

 3D View (untuk mengatur posisi chart secara keseluruhan). 



 
 

 Chart Type (untuk mengatur jenis diagram yang diinginkan). 

 
 

 Chart Option (untuk pemberian nama sumbu, legenda, label). 



 
 

 Format Data Series (untuk mengatur tampilan misalnya warna grafik). 

 

j) Menambahkan file video 

1) Klik Insert pada Menu Bar lalu klik Movies and Sounds lalu pilih yang diinginkan. 

2) Setelah memilih file maka akan keluar kotak dialog apakah ingin movie langsung 

dijalankan atau harus di klik terlebih dahulu maka pilihlah sesuai kebutuhan. 

 

k) Membuat Hyperlink 

1) Klik kanan bagian yang ingin di Hyperlink lalu pilih Hyperlink. 

2) Isikan alamat tujuan yang ingin dituju. 

 

l) Menampilkan Slide (Slide Show) 

1) Klik icon Slide Show. 

2) Hasil slide-slide yang telah dibuat akan ditampilkan sesuai dengan apa yang telah 

diatur. 

3) Untuk keluar dari Slide Show tekan End Show. 

 

2. New From Design Template 

Keunggulan yang ditawarkan Design Template ini adalah kemudahan pemilihan 

background mengingat di sini disediakan berbagai pilihan template background yang dapat 

dipergunakan untuk menghiasi slide. Tampilan yang ada bila memilih New From Design 

Template : 

 



 
 

Pada sebelah kanan nampak pilihan templates background yang telah disediakan oleh 

Microsoft Power Point yang dapat langsung dipergunakan sebagai background presentasi. 

Biasanya background yang tersedia disediakan untuk 2 bagian yakni slide judul dan juga 

slide isi. Pilih salah satu template yang diinginkan dengan meng-klik-nya. Setelah itu kita 

juga dapat mengganti warna-warna yang ditawarkan dengan menggantinya pada Color 

Schemes dan juga mengganti animasi yang ada dengan mengganti pada Animation 

Schemes. Sedangkan cara mengisi slide-nya sama dengan cara mengisi slide kosong. 

 

D. Import Outline dari Document Word 

Dalam melakukan import terhadap Outline maka syarat yang harus terpenuhi adalah kesiapan 

file Outline itu sendiri, maksudnya file yang akan dimasukkan telah dibuat dengan 

menggunakan Microsoft Word dan file tersebut tidak dalam keadaan sedang diakses. 

 

Caranya : 

 

1. Buat file word yang ingin dimasukkan. 

Contoh: 



 
 

2. Posisikan kursor pada slide sebelum slide yang akan disisipkan. 

Misalnya untuk menyisipkan slide pada lembar ke-2 maka yang di klik adalah slide pada 

lembar pertama. 

 
 

3. Klik menu Insert pilih Slide From Outline. 

4. Muncul dialog Insert Outline lalu cari file yang ingin disisipkan lalu klik  Insert. 

5. Outline akan tersisip akan tetapi masih memerlukan beberapa penyesuaian mengingat tiap 

bagian file yang menggunakan enter dianggap sebagai slide baru. Penyesuaian akan 

dilakukan dengan bantuan promote, demote, move up dan juga move down. 



 
 

Promote, Demote, Move Up dan Move Down 

 

 
 

 Promote digunakan untuk menaikkan level (bergeser ke kiri) 

 Demote digunakan untuk menurunkan level (bergeser ke kanan seperti  tab) 

 Move Up digunakan untuk menggeser slide selembar ke atas 

 Move Down digunakan untuk menggeser slide selembar ke bawah 

 

 

Dengan prinsip di atas maka slide yang sebelumnya telah dibuat dapat disesuaikan 

sehinggadiperoleh tampilan sebagai berikut : 



 
 

E. New From Auto Content Wizard 

Penggunaan Auto Content Wizard adalah untuk lebih mempermudah pembuatan slide dimana 

telah disediakan kerangka-kerangka yang sering digunakan oleh pembuat slide presentasi. 

Keunggulan teknik ini adalah pada segi kecepatan pembuatan walaupun jenis yang disediakan 

masih terbatas. Kotak Dialog berikut akan muncul disini dapat diamati bahwa proses wizard 

ini akan melalui 3 tahapan yakni Presentation Type, Presentation Style, dan juga Presentation 

Option. 

 

Klik Next maka akan diperoleh kotak dialog sbb: 



 

Pilih salah satu tipe presentasi yang diinginkan lalu klik Next dan kotak dialognya berubah 

menjadi sbb : 

 

 On Screen Presentation 

Jenis presentasi yang ditampilkan pada layar monitor dengan segala efek animasinya. 

 Web Presentation 

Jenis presentasi berupa halaman web dan nantinya bisa diakses ke web server tujuannya 

untuk memenuhi kebutuhan pemakai internet yang ingin melihatnya. 

 Black and White Overheads 

Jenis presentasi yang outputnya akan dicetak pada transparansi hitam putih. 



 Color Overheads 

Jenis presentasi yang outputnya akan dicetak pada transparansi yang berwarna. 

 35mm slides 

Jenis presentasi yang outputnya akan dicetak pada lembar slides 35mm.  

Misal pilih On Screen Presentation, kemudian klik Next. 

 

Isikan Judul dan juga Footer yang ingin ditampilkan setelah itu tekan Next 

 

Proses wizard telah selesai sehingga tekan tombol Finish. 

Hasil: 



 

Diperoleh slide yang telah jadi. Dimana telah terdapat effect dan juga slide translation. 

Selain itu juga dapat diperoleh point-point yang biasanya digunakan dalam membuat 

presentasi sesuai dengan topik yang telah kita pilih. Kita tinggal menyesuaikan isinya dengan 

yang akan dipresentasikan saja.  

 


